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Read Me First 
Welcome to Take Control of Photos, Third Edition, version 3.1, pub-
lished in November 2022 by alt concepts. This book was written by 
Jason Snell and edited by Joe Kissell. 

This book helps you get started with Apple’s Photos app on a Mac, 
iPhone, and iPad. It focuses on importing libraries from older apps, 
managing your media inside Photos, and using Photos to edit and 
share your media with friends, relatives, and the world at large. 

If you want to share this ebook with a friend, we ask that you do so 
as you would with a physical book: “lend” it for a quick look, but ask 
your friend to buy a copy for careful reading or reference. Discounted 
classroom and user group copies are available. 

Copyright © 2022, The Incomparable Inc. All rights reserved. 

Updates and More 

You can access extras related to this ebook on the web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount. 

• Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

• Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

If you bought this ebook from the Take Control website, it has been 
added to your account, where you can download it in other formats 
and access any future updates. 
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What’s New in Version 3.1 

Version 3.0 of this book inadvertently omitted coverage of an impor-
tant new feature in Photos: duplicate detection. It’s now explained in 
Manage Duplicates. 

What’s New in the Third Edition 

In macOS 13 Ventura, iOS 16, and iPadOS 16, Photos has grown and 
changed. As a result, I’ve updated and expanded this book. Along with 
many smaller changes, this edition adds the following: 

• Coverage of shared photo libraries: Apple has introduced the 
capability to share a single library among up to six Apple IDs. There 
are a bunch of limitations and caveats, but it’s a great feature that 
solves the problem of families not being able to easily build a single 
reference point for all their photos. All the details are in Use iCloud 
Shared Photos. 

• Explanation of live search in Photos: In 2021 Apple intro-
duced Live Text, a feature that let you search for text that was 
visible in photos themselves. Unfortunately, that feature wasn’t 
available within the Photos app itself! Fortunately, things have 
changed. You can now search for text directly within your photos, as 
covered in Search for Text in Images. 

• Expanded coverage of iPhone & iPad Photo Features: iOS 
16 and iPadOS 16 include a bunch of new ways to display your 
photos on your iPhone, most notably on the new customizable lock 
screen. Those features are detailed in the chapter Show off Photos 
in iOS and iPadOS. 

• Camera app instructions: There are a bunch of new options in 
the Camera app that are directly connected to Photos, so many that 
I’ve finally given in and written a new chapter, Use the Camera App, 
to give an overview of what’s in the iOS/iPadOS Camera app. 
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Introduction 
In 2002, Apple introduced iPhoto as a way for us to save our photos on 
our Macs inside a “digital shoebox.” I’d owned a digital camera for 
three months, and had only a few hundred digital images. Over the 
years, as my photo collection grew, Apple revised iPhoto—and, in 2014, 
transformed it into Photos. Over time, this has allowed Apple to unify 
the photography apps it had created for its devices. 

In this book, I describe how to perform essential tasks with Photos on 
a Mac, iPhone, and iPad. Apple deploys some of the most powerful 
functionality it has developed—including its iCloud servers and its 
machine-learning technology—in the service of making your photo 
collection more accessible and discoverable. 

My daughter, whose birth was the motivator for my very first digital-
camera purchase, is finishing college now. Her entire life has been 
chronicled with digital photos—tens of thousands of them at this point. 
That catalog, which spent time in several photography apps including 
iPhoto, now resides in my iCloud Photos, accessed via Photos on my 
devices. Photography is how we preserve the images of our lives; it’s 
important that we understand the software that allows us to organize, 
view, and share those images. That’s what you’ll learn here. 

The version of the book you are reading has been updated to reflect the 
changes in Photos version 8.0, which was released along with macOS 
13 Ventura, iOS 16, and iPadOS 16 in the fall of 2022. You can find an 
overview of the changes in Photos (and, by extension, in this edition of 
the book) by reading What’s New in the Third Edition. 

Thanks for joining me on this journey. Let’s get started! 
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Photos Quick Start 
This book explores Apple’s Photos app (in macOS, iOS, and iPadOS) by 
walking you through the most essential tasks. You can read the chap-
ters in any order. Click any link to jump to a topic. 

Get organized: 
• Photos has lots of features, and it can be a bit overwhelming when 

you first launch it. Get oriented with Navigate the Photos Interface. 
• Individual items, whether they’re photos or videos, carry with them 

a lot of metadata, including tagging made by you as well as deep 
analysis by Apple’s machine-learning engine. Read Work with a 
Single Item to get a sense of what tools are available to you. 

• Photos provides numerous methods for you to organize your li-
brary, from favorites to keywords to albums and Smart Albums. See 
all your options in Organize Your Items. 

Explore your collection: 
• Apple’s machine-learning engine allows the app to identify objects, 

animals, and faces. And almost every camera these days embeds 
geographic data on all photos. Read Use Search to Find Items to 
learn how to find exactly what you want. 

• Learn how Apple automatically identifies the people in your photos, 
as well as how to put names to faces in Name and Search People. 

• Remember Christmas three years ago? Photos does. Peruse Photos-
generated slideshows of your photos. Check out Relive Moments 
with Memories for much more. 

Perfect your photos: 
• Give photos a little extra “pop” by cropping, applying filters, and 

fixing red-eye and rotation problems. See Make Quick Fixes. 
• Learn how to Make More Complex Edits by removing unwanted 

details and applying adjustments, as well as editing with external 
apps if you prefer. 
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Sync your photos with iCloud: 
• Make your photos accessible on every device connected to your 

Apple ID by learning how to Sync with iCloud Photos. 

• The new iCloud Shared Photos feature allows you to pool your 
library with up to five other people. See all the details in Use iCloud 
Shared Photos. 

Import and manage photos: 
• Photos for macOS, iOS, and iPadOS can import files directly from 

your camera or memory card. Read Import Your Files into Photos. 
• On a Mac, you can switch between libraries to keep collections 

separate and merge different libraries together. See Manage the 
Library. 

• If you shoot a lot of photos and videos on your iPhone or iPad, you’ll 
want to know how best to capture those items by reading Use the 
Camera App. 

Show off your photos: 
• Put photos right on your iPhone and iPad’s Home screen with new 

widgets, and on your iPhone’s lock screen in iOS 16. See Show off 
Photos in iOS and iPadOS. 

• Admire your favorite photos in your living room or your wrist when 
you View Photos on Apple TV and Apple Watch 

• Don’t let your photos stay locked up on your Mac. Learn the easiest 
ways to Share Your Stuff with others using social media and more. 

• If your desired method of sharing your photos involves getting them 
out of Photos, Export and Resize Images. 

• Turn a special event’s photos into a beautiful movie with its own 
soundtrack. See Make Slideshows in Photos. 

• For all the convenience of digital photos, there’s still nothing quite 
like holding an image of loved ones in your hands. Discover how to 
use new third-party extension apps to design printed calendars and 
books. See Build Books and Calendars. 
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Navigate the Photos 
Interface 

At the center of the Photos app is the Library view, where some or all 
of your photos and videos can be displayed. Depending on your set-
tings, the Library view may display items in your library, items in a 
shared library (see Use iCloud Shared Photos), or both libraries inter-
mingled together. It might also display a curated selection of items 
organized by year, month or day, or it might display every single photo 
in your collection (Figure 1). 

Figure 1: While the main Photos interface is broken up into curated 
Years, Months, and Days views, you can still see all your items in the 
All Photos view. 

You can still switch to other views that show subsets of your collection 
by using the sidebar on Mac or iPad, or using the toolbar at the bottom 
of the iPhone screen. If you don’t see a sidebar on your iPad, you can 
make it appear temporarily by swiping from the left edge of the screen. 
To make it appear permanently, tap the Sidebar icon in the top-left 
corner of the screen. 
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Browse Your Library Through Time 

The Library view organizes your Photos library through time, with 
older items at the top and the newest ones at the very bottom. At the 
top of the screen is a set of tabs that let you choose whether to view 
Years, Months, Days, or All Photos. (You can also pinch, tap, or 
double-click to zoom in and out of the three different view levels.) 

Here’s what the different views show: 

• Years: Tiles depict single years in your library (Figure 2), with an 
image or video selected from the same time of year as the present 
day. In the summer, you see lots of beaches. In the fall, a bunch of 
kids going back to school. 

Figure 2: Revisit this month in past years with the Years view. 

• Months: Tiles appear in a couple of sizes (Figure 3), segmented 
by Photos in an attempt to detect discrete events based on time and 
location. An event might just be a single day at home, or it might be 
a weeklong trip to Europe. Apple uses a massive database of loca-
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Work with a Single Item 
Looking at a huge catalog of items in Photos is great, but once you’ve 
found a specific image or video you want to interact with, you’ll want to 
zoom into the individual item view (Figure 15). To view an individual 
item, double-click it on a Mac or tap on it on an iPad or iPhone. 

Figure 15: The individual item view lets you focus in on a single 
photo or video from your collection. 

From the individual-item view you can drill down and get more infor-
mation about your item, select text, and more. It’s also the gateway to 
editing items, which we’ll cover in the chapters Make Quick Fixes and 
Make More Complex Edits. 
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Identify Objects in Your Images 

Beginning with iOS 15/iPadOS 15 and macOS Monterey, Photos offers 
an extra layer of machine-learning-based image analysis that attempts 
to add context to the contents of your items. When the info icon on 
the toolbar is adorned with a couple of sparkly stars it means that 
your photo contains items identified by Apple’s image-analysis system. 

To access more information, you’ll need to open the Info window. At 
that point, a small circular tag appears (it appears floating above most 
identified items, though it appears in the bottom-right corner for 
landmarks), and on an iPhone or iPad you also see them listed in the 
Info window (Figure 16). Among the items that Apple’s system 
identifies are media (including book covers), art, landmarks, plants 
and flowers, and pet breeds. 

Figure 16: Photos identified this London landmark all by itself. 

To see what Apple has to say about the particular item in question, 
click or tap the small circle in the photo, or (on an iPhone or iPad) tap 
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Organize Your Items 
Apple knows most of us don’t have a lot of time to organize our photo 
libraries. That’s why Photos uses machine learning to deeply analyze 
every item in a library to figure out their contents. 

But not everyone is ready to give in to machine learning and let an 
algorithm make all the decisions about personal memories. That’s why 
Photos also contains a set of simple organizational tools that let you 
embed additional meaning into the images you’ve captured. 

Play Favorites 

Some of us like to precisely quantify things. I knew a kid in high school 
who actually rated every movie he watched on a five-star system. (He 
grew up to be a movie critic—true story!) But most of us can’t be 
bothered with complex ratings systems, so Photos uses a simpler 
approach: Favorites. 

In All Photos and album views, all your Favorites appear with little 
white hearts in their bottom-left corner (Figure 19). Awwww. (There’s 
even a subtle drop shadow, so if that corner of your photo is white, you 
can still see the heart.) 

Figure 19: Find the fave: it’s the one with the white heart in the 
bottom-left corner. 
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Click or tap Favorites in the sidebar (on an iPhone, it’s on the Albums 
tab) to see just your very best shots, as judged by you (Figure 20)! 

Figure 20: My favorite photos can be found in the Favorites view. 

Make a Favorite 

There are plenty of ways to mark an item as a Favorite on a Mac: 

• Select an item and then click the heart icon located toward the 
right side of the toolbar (Figure 21). 

Figure 21: Show your love with the heart icon. 

• Select an item and press the Period (.) key. 

• Hover your pointer over the item and click the heart that appears. 

• Select an item and choose Image > Add to Favorites. 

• In the Info window (press ⌘-I), click the heart in the upper-
right corner. 

To favorite an item on an iPhone or iPad, touch and hold the item and 
choose Favorite from the pop-up menu. If you’re already viewing the 
individual item at full size, you can tap the heart icon on the tool-
bar. (If the heart is filled in, the item is already a favorite. You can un-
favorite the item by tapping it again.) 
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Use Search to Find Items 
I used to manually tag and keyword all my digital photos and curate 
photo albums for every major life event, but the number of shots I took 
kept accelerating, and at some point I just gave up. I’m not alone—but 
advanced computer vision technology has come to the rescue! 

All the images in Photos libraries are scanned millions of times with 
machine-learning algorithms to identify thousands of different scenes 
or objects as well as unique faces (see Name and Search People for 
more on face-detection). Photos even scans for more detailed features 
like animal breeds and art (see Identify Objects in Your Images for 
details), as well as text that appears in your items. 

This makes the Search feature in Photos incredibly powerful. Want to 
find a photo featuring a dog? Just type dog in the search field. The 
automatically generated Dog category provides you with possibilities 
(Figure 32). And that’s just the beginning. While you may want to 
keep manually organizing your photo library, you may find that the 
search features in Photos make that labor unnecessary. 

Figure 32: Photos can do tricks like identify dogs in photos. (No-
body’s perfect, though—it also found a few cats.) 
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Embrace the Search Field 

Apple has spent the last few years investing enormous amounts of 
resources in building machine-learning-based features for image 
search. As a result, the Search feature is now probably the most impor-
tant single feature in Photos. You can quickly search keywords (Fig-
ure 33), titles, or descriptions. Enter a year, or a month and a year, or 
a date, and you see all the photos and videos taken then. 

Figure 33: Type the name of a location (here, the island of Maui) to 
see all the pictures you took there. 

I rely on the Search feature for navigating my library of nearly 100,000 
items, and I highly recommend it. When in doubt, use the search field! 

On a Mac, if you don’t see the search field in the upper-right corner, 
back out to a broader viewing level, such as the main level of an album. 
On an iPad, there’s a Search item in the sidebar. On an iPhone, the 
Search icon is located in the bottom-right corner of the screen. 

Quickly Jump to Dates 
Type a month and year combination to see all items created on that 
date. So, for example, I enter August 2004 to see all the items from 
the month my son was born. 
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Name and Search People 
Photos performs billions of computations on every photo to analyze its 
contents for faces, scenes, and objects. But while Photos is good at 
recognizing faces, it’s terrible at putting names to those faces. Unless 
you’ve been diligent about adding everyone whose picture you take to 
the Contacts app (complete with a picture that Photos can use to 
identify them), you need to do some work in the People view (Figure 
43), located in the sidebar on a Mac or iPad and in the People & Places 
section of the Albums view on an iPhone, to teach Photos who’s who. 

Figure 43: The People view is a catalog of familiar faces, and it’s 
where you teach Photos who is who. 

Find All Items Containing a Person 

The People view contains all the faces Photos has identified and 
connected to a name. If you want to find images of a specific person, 
this is the place to go—just select a person to see all the items that 
Photos has matched to that face. You also find a map showing all the 
places where images of this person were captured, a list of other people 
who are frequently seen with this person, and even automatically-
generated Memories (see Relive Moments with Memories) that this 
person appears in (Figure 44). 
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Figure 44: The page for my friend John lets me browse all pictures, 
locations, and Memories he appears in, and even shows me other 
people he’s usually seen with. 

Having your items tagged based on who’s in them is a great organiza-
tional tool. For example, when it’s time to find photos of my family for 
our holiday cards and annual calendars, I can use a smart album on a 

60 

Click here to buy the full 205-page “Take Control of Photos” for only $14.99!

https://www.takecontrolbooks.com/cart/?add-to-cart=1247


            
              

         
    

              
            

            
        

             
             

           
            
               

          
         

        
    

Make Quick Fixes 
Photos has a bunch of simple tools that can improve your photos and 
videos quickly and without a lot of fuss. In this chapter, I focus on 
these “quick-fix” options. For more advanced editing, see the next 
chapter, Make More Complex Edits. 

For most edits, you’ll need to enter Edit mode. On a Mac, select an 
item and press Return. (If you’re already viewing a single image, you 
can either press Return or click the Edit button in the top-right 
corner.) Move between different items with the arrow keys without 
leaving Edit Mode. When you’re done, click Done to exit the view. On 
an iPhone or iPad, tap to open a single item and then tap Edit. 

When you’re in Edit mode, the entire Photos interface changes. You’ve 
got access to three different sets of editing tools, which are displayed as 
tabs on a Mac and as icons on an iPhone or iPad: Adjust , Filters , 
and Crop (Figure 51). (You can also edit Live Photos from this 
mode. For more information on that, see Edit Live Photos.) 

Figure 51: The Edit pane consists of a large image preview, tabs, 
and a strip of controls down the right side. 
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Tip: Two of the quick-editing features in Photos are so quick, they 
don’t even require you to enter editing mode on a Mac. These items 
appear on the toolbar in the top-right corner of the Photos window. 
Rotation is accessible at all times, and Auto Enhance is acces-
sible after you double-click any photo. You can also press ⌘-E at any 
time to auto-enhance a selected photo. 

Use Auto Enhance 

While Photos gives you lots of tools to tweak your items very carefully, 
it also offers a sophisticated auto-enhance feature. You can activate it 
by clicking the Auto Enhance icon, which is always visible on the 
toolbar on a Mac and accessible from the Adjust controls  on an 
iPhone or iPad. When you Enhance an item, Photos analyzes it and 
makes its best guess about the proper levels, color, and more (Figure 
52). 

Figure 52: The Enhance feature tries to improve your photo, but 
usually doesn’t overdo it. (Here, the right image is enhanced; the left 
is the original.) 

Since it’s operated by a computer and not a human, the Auto Enhance 
feature won’t solve every problem. Sometimes it makes your item look 
worse, and other times it can be a bit too timid. But it’s always worth a 
try if you’re not confident using the more advanced features under the 
Adjust icon. Even better, Auto Enhance’s techniques aren’t meant to 
be a mystery—every adjustment it makes is reflected in the detailed 
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Make More Complex Edits 
Basic adjustments of the kind I described in the previous chapter, 
Make Quick Fixes, are often all you need to make your photos and 
videos come to life. But sometimes you need do more. 

On a Mac, select an image and press Return (or if you’re viewing a 
single image, click the Edit button in the top-right corner) to enter Edit 
mode. On an iPhone or iPad, tap to view an item and then tap the Edit 
button. Then click or tap Adjust (designated by the icon on an 
iPhone or iPad). You see numerous tools you can use to make your 
photos and videos look their best (Figure 58). 

Figure 58: Exterminate all your items’ flaws with the Adjust mode of 
the Edit view. 

Adjust The Look Of Items 

The adjustment controls in Photos are slightly different on a Mac and 
on an iPhone or iPad. On a Mac, you find 13 different controls on the 
right side of the window. When you hover over them, you see that 
many offer an Auto button to automatically apply basic adjustments, 
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as well as an undo arrow . Click the disclosure arrow to the left of 
any item to see the controls that live underneath (Figure 59). 

Figure 59: Many adjustment options on a Mac have a primary 
control (visible once you click the disclosure arrow) made up of 
component options you can display by clicking another arrow. 

Many, but not all, of the adjustment controls offer an interface where 
you drag a control across a horizontal bar. The center position general-
ly means no effect is applied, while dragging to the right or left applies 
an effect positively or negatively. For example, as you slide the Color 
control to the right, your image becomes increasingly saturated. If you 
slide it to the left, the color gradually drains away. 

On an iPhone or iPad, the controls vary depending on your device and 
its orientation. In Adjust mode (Figure 60), 16 controls display as 
icons inside circles either on the right side of the screen (iPads and 
iPhones held horizontally) or at the bottom (iPhones held vertically) 
(Figure 61). 
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Use the Camera App 
The Camera app in iOS and iPadOS is the gateway to the Photos 
library. I’d bet good money that the vast majority of items in iCloud 
Photos come from photos and videos taken with the Camera app on 
iPhones and, to a lesser extent, iPads. With each successive release of 
its operating systems, Apple tightens the integration between the 
camera app and the Photos library. So it’s worth taking a spin through 
the Camera interface (Figure 83) to point out how your settings can 
impact what’s saved to your photo library. 

Figure 83: Control icons always stay at the “top” of the phone 
(where the earpiece slit is, left), while capture types and zoom 
controls stay on the “bottom” (where the charging port is, right). 

Navigate the Camera Interface 

The bulk of the Camera app’s interface is, of course, a preview of the 
image you’re capturing. But there’s a lot more to it than that. There are 
a set of control icons that you can use to toggle features on and off, a 
series of available capture types to determine just what the app should 
be capturing and saving, and even a thumbnail to get you a quick view 
of recently captured images. 
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On an iPad, both the control icons and the capture types are on the 
right side of the screen, on either side of the big capture button (Fig-
ure 84). Any zoom controls are found on the left. 

Figure 84: iPad controls (except for zoom) are kept on the right 
side, regardless of orientation. 

On an iPhone, the control icons live at the edge of the phone where the 
earpiece and forward-facing camera and sensors are located. When 
you’re holding the iPhone in its usual vertical orientation, this is the 
top, but the icons stay on that edge regardless of how you rotate the 
phone. Capture types and zoom controls likewise stay on the opposite 
side of the preview, on what is the bottom side of the phone if you’re 
holding it vertically. 

Identify the Control Icons 
While different capture types present different control icons, many of 
them are shared across multiple capture types. Here are the icons 
you’re likely to see in the Camera interface: 
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Import Your Files into 
Photos 

If you use iCloud Photos, the images you take on your devices automat-
ically sync to all your other devices (see Manage the Library), but 
sometimes you may end up shooting photos and video with a stand-
alone camera, or might have someone hand you a memory card or USB 
drive loaded up with photos and videos. Photos can handle these 
classic methods, of course (Figure 85). 

Figure 85: When you attach a camera or iOS device or insert a 
memory card, Photos displays the contents on the Import pane. 

You probably want to import your files directly into Photos, though 
there are some instances where you might prefer to import them into 
your device’s filesystem first and then add them to Photos later. If you 
plan to modify your images in some way before Photos ingests them, or 
(on a Mac) if you’d prefer to manually manage where your files are 
stored, use the second approach. 
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Import Files Directly 

On a Mac, you can always import image and video files directly into 
your library by dragging them from the Finder into the main Photos 
window, or onto the Photos icon in the Dock. You can also choose 
Import from the File menu. Unless you’ve turned on the manual 
management of items (see Manage Files Yourself on a Mac), the file is 
copied into the Photos library. 

On an iPhone or iPad, you can select a file in the Files app, tap the 
Share icon, and choose Save Image or Save Video to import that file 
into the Photos library. If you want to select more than one file, tap 
Select, select the items you’d like to import, tap Share, and tap Save X 
Videos or Photos (Figure 86). 

Figure 86: Selecting multiple video files in the Files app. 
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Manage the Library 
At the heart of Photos in macOS is the concept of the library. (In iOS 
and iPadOS, there’s only one library—or two if you are using iCloud 
Shared Photos. See Use iCloud Shared Photos for more.) You can have 
more than one library on a Mac, but only one can be synced with 
iCloud. 

Here are the details of mixing, matching, and merging libraries in 
macOS. 

Understand the System Photo Library 

To simplify the process of syncing files with iCloud, Apple has limited 
Photos to a single System Photo Library. This is the library that’s 
capable of syncing to iCloud (see Manage the Library). There can only 
ever be one at a time (Figure 94). 

Figure 94: If you’re not using the System Photo Library, you find no 
iCloud options whatsoever in the Photos settings. 

You can designate a new System Photo Library at any time. To do so, 
open a different library, choose Photos > Settings > General, and click 
the Use as System Photo Library button. But be warned! This leads to 
the contents of your new System Photo Library and your existing 
iCloud Photos library (if you have one) being merged together into one 
big library. 
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Which Library Is Which? 
To help you differentiate between libraries in the Choose Library 
dialog, Photos adds the parenthetical phrase System Photo Library 
after the library that’s capable of syncing with iCloud Photos. If the 
library you’ve opened most recently is not your System Photo Library, 
Photos adds the phrase Last Opened after that library. If you click 
any library, Photos displays the entire file path in text just below the 
list of libraries. 

Use Multiple Photos Libraries on Mac 
Most people will probably use a single library with Photos. But if you’re 
using a Mac and want to keep strict separation between different 
media collections, it’s easy to create multiple libraries in Photos and 
switch between them (Figure 95). 

Figure 95: Two different Photos libraries, with entirely different sets 
of media. 

Reasons to Have Many Libraries 
There are plenty of scenarios that might lead you to want more than 
one library: 

✦ Create one for each client, if you’re a freelance photographer. 

✦ Keep your work photos separate from the family stuff. 

✦ Let your kids mess with their photos without trashing your library. 

✦ Separate the files you want to sync to iCloud from ones you don’t. 
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Sync with iCloud Photos 
While Photos works fine as a standalone image library, it’s built to 
connect with Apple’s online service, iCloud. With iCloud Photos, all 
your devices can view items stored in a single online library—and add 
new items to it—giving you access to every item in your media collec-
tion from any device (Figure 99). 

Figure 99: Check the iCloud Photos box in Photos > Settings > 
iCloud to sync with iCloud. 

Uploading your Photos library to iCloud adds convenience and a 
measure of safety to your photo collection, but there are numerous 
complications to this process, too. 

The Cost of Cloud Storage 
As of this writing, every Apple ID comes with 5 GB of free iCloud 
storage. 50 GB of iCloud space (including not just your photos and 
videos but also your iPhone and iPad backups, as well as iCloud Drive 
files) costs $0.99 per month, 200 GB costs $2.99 per month, and 2 
TB costs $9.99 per month. If you subscribe to the Apple One bundle, 
you get 2 TB of iCloud storage—and can still buy an additional 2 GB 
to max out at 4 TB. (To check the latest pricing and rates for different 
countries, see Apple’s iCloud storage plans and pricing page.) 

Those prices are comparable to what you’ll find at other services, 
including Google and Dropbox—but with better integration and 
syncing on Apple devices. However, if you’re an Amazon Prime 
member, you should know that Amazon Photos offers unlimited photo 
storage free for Prime members (but only 5 GB of video). It’s worth 
looking into, even if only as a second cloud backup for your images. 
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Set the System Photo Library on a Mac 

iCloud syncing works with only a single library on your Mac, which 
Apple refers to as the System Photo Library. It’s generally the first 
library that you opened when you started Photos. You can have as 
many libraries as you like (see Use Multiple Photos Libraries on Mac), 
but only one can sync to iCloud. 

To change the System Photo Library: 

1. Hold down the Option key and launch Photos. 
2. Select the library that you want to sync via iCloud, and click Choose 

Library. 
3. Choose Photos > Settings > General. 
4. Click the Use as System Photo Library button (Figure 100). 

Figure 100: Click Use as System Photo Library to make your cur-
rently open library iCloud eligible. 

Start Syncing With iCloud Photos 

When you sync with iCloud Photos, you also have to choose which 
items are retained in your device’s local storage. Here are the details. 

Turn On iCloud Photos 
To turn on iCloud Photos on a Mac, choose Photos > Settings > iCloud 
and select the checkbox next to iCloud Photos. Photos immediately 
begins uploading the entire contents of your library to iCloud. On an 
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Use iCloud Shared Photos 
Beginning with iOS 16.1 and iPadOS 16.1 and macOS Ventura, you can 
now place photos and videos in a separate library that lives alongside 
your regular Photos library (Figure 105), and share that new library 
with up to five other people. It’s called iCloud Shared Photo Library, 
and while it has limitations, it’s probably the single best way to build a 
collaborative shared pool of photos with your loved ones. 

Figure 105: When you use iCloud Shared Photo Library, you can 
display images from both your libraries simultaneously. Items in the 
shared library are indicated by an icon in the top-right corner. 

Warning! If you have a device associated with your iCloud account 
that isn’t updated to iOS or iPadOS 16.1 or later or macOS Ventura or 
later, that device won’t be able to see any photos that have been 
added to a shared library! If you have devices that haven’t yet 
updated, and you want to see all your photos on those devices, don’t 
use iCloud Shared Photos. 

Get Started With iCloud Shared Photos 

Unlike other methods of sharing photos with other people using the 
Photos app (see Share Your Stuff), iCloud Shared Photos creates a 
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second full-fledged library in parallel with your existing iCloud library. 
While your regular library is still accessible only to your Apple ID, the 
new library can be accessed by up to five other Apple IDs. And by 
accessed, I mean full access: Any participant in iCloud Shared Photos 
can edit or delete photos that are in the shared library. (For more 
details, see Who Owns What in an iCloud Shared Photos Library?) 

You can be a participant in only a single shared library at a time. If 
you’ve got a bunch of overlapping friend and family groups you want to 
share different albums with, this is not the feature for you, unfortu-
nately. It’s really designed for a single set of people whose primary 
sharing activity will be with one another. In most cases, I suspect this 
will be a family group: adult partners and, potentially, their parents or 
children. 

Create an iCloud Shared Photos library 
To get started, you’ll need to create a shared library. 

To create the library on a Mac, choose Photos > Settings and 
choose Shared Library. (If you haven’t turned on iCloud Photos yet, 
you’ll need to do that first, from the iCloud tab of the Settings window.) 
From the Shared Library tab, click Get Started to begin the process. On 
an iPhone or iPad, open the Settings app and tap Photos, then tap 
Shared Library. 

Next, you’re asked to invite participants to the shared library and move 
photos out of your personal library into the shared library (Figure 
106). Keep in mind, you can always choose Add Later and Move 
Photos Later if you don’t want to get the entire process started all at 
once. 
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Share Your Stuff 
What good are photos and videos if you can’t share them with friends? 
Traditionally, sharing photos meant sending prints or making albums. 
You can still do that—see Build Books and Calendars—but sometimes 
you want sharing to be more immediate. While iCloud Shared Photos 
is great for families (see Use iCloud Shared Photos), since you can 
share only one library, it’s not the right fit for more casual sharing. 

The answer for casual sharing is to create shared albums. You can 
share an entire album that others can update and comment on (see 
Share Using Shared Albums). And if your desired sharing method 
requires that you get your files out of Photos, you can do that too (see 
Export and Resize Images). 

Transfer Your Stuff Directly 

Sometimes you just want to get your photos or videos right out of 
Photos and into the hands of another person or another app. There are 
lots of different ways to do this: 

• Drag and drop: On a Mac, the most direct way to do this is to 
select a file or files and drag them out into the Finder or other apps. 
In older versions of macOS, Photos didn’t play well with other apps 
in terms of dragging and dropping files, but starting in Catalina it 
works pretty much everywhere. You can also drag and drop items 
from Photos into other apps using multitasking on an iPad. 

• Other apps: You can pass your items directly to another app by 
clicking or tapping the Share icon and choosing that app, 
whether on a Mac, iPhone, or iPad, though there are far fewer 
options on a Mac. 

• AirDrop: If you’re trying to directly transfer files to a device that’s 
near yours (whether it’s a Mac, iPhone, or iPad), Apple’s AirDrop is 
the best method to use. Click or tap the Share icon, choose 
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AirDrop, and pick a target device. The owner of the target device is 
prompted to accept the file transfer. (Your recipient may need to 
adjust their AirDrop settings in order to be visible on your device.) 

• iCloud Photo Sharing: If you have this feature turned on, click or 
tap the Share icon and choose Shared Albums (Mac) or Add to 
Shared Album (iPhone and iPad) to add a photo to any of your 
shared albums. (See Share Using Shared Albums, later in this 
chapter.) Images shared using this feature are reduced to 2048 
pixels on the longest edge. 

Tip: Photos offers a few different ways for you to select more than 
one photo for use with the Sharing menu. On a Mac, Shift-click or ⌘-
click to select a batch of items. On an iPhone or iPad, tap Select and 
then tap or slide your finger on items you want to select. 

Export and Resize Images 

Sometimes you need to export an image or collection of images, but 
don’t want or need them at full resolution. (This often happens when 
I’m uploading a photo as an avatar or background image for a social-
media service, where there are very specific file-size and image-size 
constraints.) This is easy to do on a Mac and more complicated on an 
iPhone or iPad. 

Export and Resize Photos on a Mac 
Photos for Mac’s Export command is powerful. Here’s how to use it for 
photos: 

1. Select the photos. 

2. Choose File > Export > Export X Photos (where X is the number of 
photos). 

3. Choose whether to export the images in JPEG, TIFF, or PNG 
format; whether or not to embed metadata such as titles, keywords, 
and locations; and which file naming convention to use. 
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Show off Photos in iOS and 
iPadOS 

What’s the point in taking photos if you can’t admire them later? Apple 
has put a lot of effort into finding ways for you to stumble on some of 
your favorite photos when you’re least expecting them. Recent soft-
ware updates have added new ways to decorate your iPhone and iPad 
with photos you select—or that Apple selects for you (Figure 127). 

Figure 127: The new lock screen in iOS 16 allows you to show off 
one favorite photo or cycle through a curated selections. 

Decorate Devices with Widgets 

Widgets allow you to see a curated selection of your Memories and 
featured photos in new places on your devices. They offer an easy, fun 
way to be surprised by favorite moments and pictures when you least 
expect it. I added a Photos widget to my iPad recently and it’s prompt-
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ed lots of reminiscence, laughter, and hilarious text-message threads 
with friends. 

To add the Photos widget on an iPhone or iPad, touch and hold on an 
empty space of your Home screen until the icons go into jiggle mode, 
tap the plus icon, then scroll down until you see Photos, and tap it. 
Then, tap Add Widget. To add the Photos widget on a Mac, click the 
clock on the menu bar to bring up Notification Center, then tap Edit 
Widgets and click Photos. 

The Photos widgets come in small, medium, large, and (on iPad) extra-
large sizes and display Memories and Featured Photos on your Home 
screen (Figure 128) or widget area on an iPhone or iPad, or in Notif-
ication Center on a Mac. 

Figure 128: A featured Memory appears on my iPhone Home 
screen. 

Numerous other apps are available that provide widgets that let you 
place favorite photos wherever widgets are found. The free iOS/iPadOS 
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Relive Moments with 
Memories 

Memories (Figure 132) are dynamically generated slideshows that let 
you relive moments without doing the work of gather everything 
together yourself. Photos chooses the pictures (and videos, including 
video from Live Photos), figures out an appropriate soundtrack, and 
brings the whole thing to life when you tap. 

Figure 132: The Memories section of For You (on an iPad) shows 
collections of images and videos that Photos thinks you might like. 

On a Mac, the Memories collection is located in the sidebar. On an 
iPad, it’s in the For You section on the sidebar. On an iPhone it’s on the 
For You tab. Memories are organized automatically by Photos based on 
a few different concepts: the recent past (“Best of Last Month”), this 
same time in a previous year (“On This Day”), locations (“Kauai 
through the years”), trips (“San Luis Obispo to San Diego”), individual 
pets (“Pet Friends Fall 2015”), and other machine-learning-related 
themes. It may seem a bit scattershot, but the idea is to help rediscover 
photos that you’d never otherwise revisit. 

In the Memories area of For You on an iPad, you can tap the heart 
icon to add a Memory to your Favorites. Tap the More  button to 
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quickly edit the title of the Memory, tell Photos to feature some of the 
people in the Memory less often (or not at all), or delete the Memory 
altogether. 

View, Share, and Edit Memories 

When you tap a Memory, it begins to play. If all you want to do is 
watch, then sit back and enjoy. It plays straight through until it reaches 
the end, at which point Photos offers you related Memories if you want 
to watch some more. 

But Memories are more than just videos. You can control them. If 
there’s a photo you want to look at for a while, just tap the image and it 
stays on screen—the music’s volume lowers, but the song keeps play-
ing. You can also swipe backward if you see something you want to 
look at a bit longer that has already been replaced on screen. Likewise, 
you can swipe forward if there’s an image or video you want to skip. 

Of course, you can do more than just watch videos. Tap once on the 
screen (on a Mac, move the pointer over the window) to bring up a set 
of controls. From here, you can: 

• Edit the music being played by the Memory by tapping or clicking 
the Music icon. 

• Move between images being used in this Memory via the thumb-
nails in the bottom-middle portion of the screen. 

• Play or pause the whole thing with the Play  or Pause icon. 

• Zoom in to a gallery of all the photos in the Memory by tapping the 
thumbnail icon. 

• Tap or click the Share icon to save the Memory as a video or 
share it with friends. 

• Tap or click the More button to make a bunch of other modifica-
tions to the Memory, as detailed below. 
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View Photos on Apple TV 
and Apple Watch 

The Photos app on iPhone, iPad, and Mac is where Apple expects you 
to manage, edit, and view photos and video. That said, there are other 
devices in Apple’s ecosystem—the Apple TV and Apple Watch—that 
have their part to play when it comes to enjoying photos in contexts 
large and small. 

View Photos on an Apple TV 

Your living room is a natural place to share photos, and your TV set 
can be an excellent canvas. You can view Memories, albums, and your 
entire iCloud Photos library in the Apple TV Photos app (Figure 134). 

Figure 134: The Apple TV Photos app gives you access to your 
iCloud Photos library, Memories, albums, and shared albums. 
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Choose What to Make Available 
When you first launch the Photos app on an Apple TV, it asks you to 
choose what images it should have access to. This is important, be-
cause Apple has anticipated that just because you’re showing off 
images to visitors on your TV, you might not want those visitors to 
have access to every single item in your library. 

If you want to open up your Apple TV for all your photos and videos, 
you’ll have to authenticate with your Apple ID (or a nearby iPhone or 
iPad) in order to unlock that feature. Otherwise, you can choose to use 
the Photos app just to display items from your Shared Albums. Then if 
there are items you want to show off to visitors, you can add those to a 
Shared Album (see Share Using Shared Albums). 

View and Play Memories 
All your Memories are viewable in the Memories view (Figure 135). 
On the top strip is a collection of recently generated Memories. Below, 
you can see all the Memories you’ve marked as favorites. 

Figure 135: Swipe left to right on the Memories pane to go back in 
time. 
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Make Slideshows in 
Photos 

When my kids were in elementary school, I couldn’t go to a school 
function without seeing at least one slideshow. Photos provides eight 
different slideshow themes (Figure 144), and if you’re the type who 
wants your slideshows just so, you have a lot of power to control 
exactly how yours behave. 

Figure 144: The Vintage Prints theme may be my favorite of the 
Photos slideshow themes. 

This chapter begins by talking about the slideshow options in Photos 
for Mac; for information about iPhone and iPad, read Make Slideshows 
in iOS or iPadOS, at the end of the chapter. 

Tip: Don’t forget that Photos can also automatically generate movies, 
which are very much like slideshows, for every Memory as well as 
many events in the Months and Days views. Click or tap the Play icon 

at the top of any Memory. In Month and Day views, click or tap 
the More button on a tile and choose Play Movie. 
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Create a Slideshow on a Mac 

To create a Slideshow, select a group of photos and choose File > 
Create > Slideshow > Photos. Give your slideshow a name and click 
OK. A new entry appears in the My Projects section of the sidebar. 

In the slideshow editor that opens, you can organize the images, 
choose a theme and music, and determine how long your slideshow 
lasts, as I describe next. 

Choose a Theme 
Click the Theme Picker icon at the right and then click a theme 
name. You can reorder the images in all themes by dragging their 
thumbnails around in the strip at the bottom of the window—drag the 
rule above the thumbnails up a bit if they’re too small (Figure 145). 

Figure 145: Choose a theme from the list at right. You can drag 
around the small images at the bottom of the screen to reorder the 
Slideshow. 
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Build Books and Calendars 
My family has a tradition of curating our very best photos and creating 
annual calendars and books. These physical products are great ways to 
keep our photos in view throughout the year, even when we aren’t 
staring at a device. 

On a Mac, you used to be able to build books and calendars and send 
them off to Apple for printing. A few years ago, Apple dropped that 
functionality. These days, you can create books and calendars directly 
within Photos via third-party app extensions available for download in 
the Mac App Store. These free apps allow you to create projects based 
on your Photos library and order them from right within Photos. 

The story’s not as strong on an iPhone or iPad, though a relatively 
recent arrival makes it more plausible to create and order books right 
from your iPad or iPhone. 

Design Books with Mimeo and Motif 

There are two apps that really excel at letting you build paper books 
and calendars within Photos on a Mac: Mimeo Photos and Motif, both 
free. I describe the process of building books in both of them below. 

Build with Mimeo Photos on a Mac 
I’ve been very impressed with Mimeo Photos (Figure 153). In general, 
I found it to be a suitable replacement for Apple’s own book-building 
tool, with some features that surpass the ones that Apple previously 
offered. 
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Figure 153: Mimeo Photos lets you build books within Photos, and 
offers some features that Apple’s implementation never did. 

To create a project using Mimeo Photos, first download the app from 
the App Store. After you launch the app and give it permission to 
access your photos, you can start a new project by selecting images or 
an album in Photos and then choosing File > Create > Book > Mimeo 
Photos. 

Choose the type of book you’d like to create (Mimeo offers six styles of 
hard- and softcover books). Click Create, select from one of more than 
50 themes, and Mimeo generates an automatic layout based on the 
images you add to the project. (I found myself deleting all those pages 
and then slowly building my own.) 

In the sidebar on the right side of the window, click Layout to view all 
the optional layouts for a page (Figure 154). Mimeo provides dozens 
of layout designs based on how many photos you want on a page or 
spread. 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find it 
both useful and enjoyable to read. We welcome your comments. 

Ebook Extras 

You can access extras related to this ebook on the web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

• Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

• Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

• Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control website, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. 

More Take Control Books 
This is but one of many Take Control titles! We have books that cover 
a wide range of technology topics, with extra emphasis on Macs and 
other Apple products. 

You can buy Take Control books from the Take Control online catalog 
as well as from venues such as Amazon and the Apple Books Store. 
But it’s a better user experience and our authors earn more when you 
buy directly from us. Just saying… 

Our ebooks are available in three popular formats: PDF, EPUB, and 
the Kindle’s Mobipocket. All are DRM-free. 
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Copyright and Fine Print 
Take Control of Photos, Third Edition 
ISBN: 978-1-990783-22-7 
Copyright © 2022, The Incomparable Inc. All rights reserved. 

alt concepts, 419 8B-3110 8th St. East, Saskatoon, SK S7H 0W2 Canada 

Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, they should buy a copy. Your support 
makes it possible for future Take Control ebooks to hit the internet long before you’d find 
the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any 
free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and alt concepts have made a reasonable effort 
to ensure the accuracy of the information herein, they assume no responsibility for errors 
or omissions. The information in this book is distributed “As Is,” without warranty of any 
kind. Neither alt concepts nor the author shall be liable to any person or entity for any 
special, indirect, incidental, or consequential damages, including without limitation lost 
revenues or lost profits, that may result (or that are alleged to result) from the use of these 
materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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